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ВСТУП 

Курс забезпечує студентів спеціальними знаннями з теорія та практика 

мультимедіа, сприяє осмисленню та засвоєнню студентами сутності, 

структури, рівнів, функцій, форм та концепцій мультимедіа; допомагає 

сформувати навички організації практичної роботи з мультимедіа. 

Метою навчальної дисципліни є розширення знань та формування 

практичних умінь і навичок майбутніх культурологів з питань теорії та 

практики мультимедіа; вивчення принципів та методів побудови візуальних 

сцен на моніторі комп’ютера, методів обробки візуальної та звукової 

інформації, ознайомлення з алгоритмами та методами побудови анімацій 

живих та неживих об’єктів, з методами проектування та керування 

мультимедійними проектами. 

Основними завданнями навчального курсу є ознайомлення студентів з 

понятійно-категоріальною системою курсу; введення інноваційних елементів у 

формування планів, принципів роботи із растровими та векторними 

зображеннями, засобами створення об’єктів тривимірної графіки, 

мультимедійних проектів та комп’ютерної анімації, проєктів мультимедіа з 

урахуванням сучасних запитів, тенденцій технологічного розвитку 

суспільства, креативної та цифрової культури. 

 

1. Структура та зміст освітньої компоненти 

1.1. ЛЕКЦІЙНІ ЗАНЯТТЯ 

Лекцій – 24/4 год. Практичні –38/16 год. Самостійна робота – 118/160 год. 

Змістовий модуль 1. 

Тема № 1. Основи курсу "Теорія та практика мультимедіа" (2 год.) 

Вступ до дисципліни: мета, завдання, предмет та  компетенції. Введення в 

інформаційні мультимедійні технології. Поняття мультимедіа. Визначення 

мультимедійної інформації. Місце мультимедійних видань в культурології. 

Тема № 2. Поняття мультимедійних технології в культурології (2 год.) 

Поняття мультимедіа. Мультимедіа продукт. Мультимедіа технологія. 

Класифікація мультимедіа продуктів. Складові мультимедіа. Інструменти 

створення мультимедіа. Функції та задачі мультимедійних інформаційних 

систем. Стандарти в галузі мультимедійних інформаційних систем в 

культурології. 

Тема № 3. Класифікація і огляд типових мультимедійних технологій в 

культурології (2 год.) 

Представлення мультимедійної інформації. Зорове і слухове сприйняття 

мультимедіа. Формати представлення мультимедійної інформації. Формати 

документів. Формати анімації і цифрового відео.  
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Тема № 4. Технічне та програмне забезпечення (2 год.) 

Пристрої введення/виведення графічної інформації. Програмне 

забезпечення комп‘ютерної графіки. Графічні редактори. Мови програмування 

графіки. Графічні засоби відеосистем. Види комп‘ютерної графіки. Графічні 

файлові формати. 

Тема № 5. Обробка зображень в середовищі Photoshop (2 год.) 

Растрова графіка. Види растрів. Фактори, що впливають на кількість 

пам'яті, займаної растровим зображенням. Про стиск растрової графіки. 

Геометричні характеристики растра. Кількість кольорів растрового 

зображення. Роздільна здатність. Засоби для роботи з растровою графікою. 

Тема № 6. Обробка тексту, як складової мультимедіа в культурології (2 

год.) 

Поняття тексту та його форми. Види текстової інформації. Способи та 

засоби введення тексту. Розпізнавання тексту. Засоби для створення 

мультимедійних видань. Створення мультимедійних презентацій. 

Застосування засобу Adobe Acrobat для створення мультимедіа продукту. 

Змістовий модуль 2. 

Тема № 7. Моделі кольору (2 год.) 

Природа кольору. Моделі кольорів. Адитивна модель кольору RGB. 

Субтрактивна модель кольорів CMY/CMYK. Баланс кольорів. Кодування 

кольору. Палітра кольорів. Оптимальне поєднання кольорів при побудові 

зображень в мультимедіа.  

Тема № 8. Моделі графічних об’єктів, як складової мультимедіа в 

культурології 

 (2 год.) 

Простіші моделі графічних об’єктів. Інформаційна модель. Математична 

модель. Комп’ютерна модель. Моделювання. Сучасні мови моделювання. 

Геометричні примітиви. Методи 3D-моделювання: полігональне моделювання, 

сплайнове моделювання, середовища програмування. Воксельні моделі. 

Поверхні вільних форм (функціональні моделі). 

Тема № 9. Обробка зображень в середовищі CorelDRAW Graphics Suite 

(2 год.) 

Інтерфейс робочого вікна. Коротка характеристика Toolbox (Палітри 

інструментів). Диспетчер об’єктів. Властивості об’єктів. Робота з шарами. 

Лінійки.Направляючі лінії. Масштабування. Інструменти Zoom і Нand. 

Диспетчер Видів (View Manager). 

Тема № 10. Обробка звуку, як складової мультимедіа в культурології (2 

год.) 

Поняття звуку. Частота та гучність звуку. Звукові сигнали. Робота зі 

звуком: аналогове-цифрове перетворення, цифро-аналогове перетворення, 

дискретизація, квантування. Синтез звуку. Стиснення звукової інформації. 
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Стандарти звуку та формати файлів. Програмні та апаратні засоби обробки 

звуку. Пристрої для роботи із звуковою та відеоінформацією. Програмне 

забезпечення для створення та обробки звуку. 

Тема № 11. Обробка відео, як складової мультимедіа в культурології (2 

год.) 

Аналоговий сигнал та його функції. Цифровий відеозапис та телебачення. 

Комп’ютерна анімація. Стиснення відеоінформації. Засоби відображення 

відеоінформації в мультимедіа. 

Тема № 12. Принципи проектування і створення мультимедійних 

технологій в культурології (2 год.) 

Стандарти проектування і виготовлення мультимедійних технологій. 

Принципи розробки мультимедіа. Критерії аналізу та розробки мультимедійних 

проектів. 

1.2. ПРАКТИЧНІ ЗАНЯТТЯ  

(проводяться з використанням ПК) 

Змістовий модуль  1 

1. Цифрові технології НУВГП мультимедійних технологій в культурології  

2.  Створення презентації в Power Point на тему "Аспекти діяльності 

масмедіа у вітчизняному телекомунікаційному просторі"  

3. Створення презентації в Prezi медіа технологій у сфері культурології  

4. Цифрові технології роботи з електронними документами: створення 

мультимедійної електронної книги  

5. Створення складної графічної композиції за допомогою програми 

Photoshop для художнього оформлення тексту і створення спец ефектів  

6. Тестовий контроль № 1 

Змістовий модуль  2 

7. Створення цифрового фотоальбому про сучасні медіакомунікації: 

перспективи розвитку інформаційних технологій у сфері культури та 

теорія і практика медіакультури  

8. Створення складної графічної композиції за допомогою програми 

CorelDraw для ілюзії скла, листа календаря, міста  

9. Створення відео презентації за допомогою програми Canva у галузі 

віртуального простору сучасного мистецтва  

10. Створення відео презентації в YouCut для практичного використання 

індустріями культури  

11. Тестовий контроль № 2  
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2. ЗМІСТОВИЙ МОДУЛЬ 1 

ПРАКТИЧНА РОБОТА № 1 

ТЕМА: Цифрові технології НУВГП мультимедійних технологій в 

культурології (4 год.) 

Мета заняття: одержання практичних роботи з цифровими технологіями 

НУВГП.  

Зміст: Після виконання практичної роботи студент повинен 

знати: 

• функціональні можливості сервісу сайту НУВГП; 

• особливості здійснення процесів роботи з корпоративною поштою, 

електронним журналом, Moodle, Help Desk, вікісітет, репозиторій; 

• особливості настроювання параметрів та процес роботи сервісу та 

служби Google, створення реклами в Google Ads; 

вміти: 

• переглядати сервіси сайту НУВГП 

• працювати з корпоративною поштою, електронним журналом, 

Moodle, Help Desk, вікісітет, репозиторій; 

• виділити позитивні та негативні моменти використання 

мультимедійних технологій; 

• внести пропозиції та вміти реалізувати їх. 
 

ЗАВДАННЯ: 

Проаналізувати роботу цифрових технологій НУВГП в культурології, виділити 

позитивні та негативні моменти використання мультимедійних технологій, внести 

пропозиції та продемонструвати їх. 

 

ПРАКТИЧНА РОБОТА № 2 
ТЕМА: Створення презентації в Power Point на тему "Аспекти діяльності 

масмедіа у вітчизняному телекомунікаційному просторі" (4 год.) 

Мета заняття: одержання практичних навичок з організації процесів 

створення, редагування та керування демонстрацією інтерактивної презентації 

засобами Power Point. 

Зміст: Після виконання практичної роботи студент повинен 

знати: 

• функціональні можливості Power Point; 

• особливості здійснення процесів створення, редагування, перегляду, 

керування демонстрації; 

• особливості настроювання параметрів презентації; 

• специфіку створення та використання слайдів; 

вміти: 
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• створювати, редагувати, переглядати, керувати презентацію та 

передавати її засобами мережі; 

• визначати шлях переміщення презентацією; 

• працювати з параметрами настроювання елементів презентації; 

• створювати мультимедійні презентації; 

• використовувати та модернізувати шаблонні конструкції для 

створення презентацій; 

• настроювати властивості всього проекту и окремих його сторінок 

(слайдів); 

• вмонтовувати анімацію, відео, аудіо, фото, текст; 

• здійснювати командну роботу над презентацією. 

 

ЗАВДАННЯ: 

Створення презентації на тему "Аспекти діяльності масмедіа у вітчизняному 

телекомунікаційному просторі". 

 

ПРАКТИЧНА РОБОТА № 3 
ТЕМА: Створення презентації в Prezi медіа технологій у сфері 

культурології (4 год.) 

Мета заняття: одержання практичних навичок з організації процесів 

створення, редагування та керування демонстрацією інтерактивної презентації 

засобами on-line сервісу prezi.com. 

Зміст: Після виконання практичної роботи студент повинен 

знати: 

• функціональні можливості on-line сервісу prezi.com; 

• особливості здійснення процесів створення, редагування, 

перегляду, керування демонстрації, конвертації в off-line та 

передачі засобами мережі інтерактивної презентації; 

• особливості настроювання параметрів елементів презентації; 

вміти: 

• створювати, редагувати, переглядати, керувати демонстрацією, 

конвертувати в off-line інтерактивну презентацію та передавати її 

засобами мережі; 

• визначати шлях переміщення презентацією; 

• працювати з параметрами настроювання елементів презентації; 

• здійснювати командну роботу над презентацією. 
 

ЗАВДАННЯ: 

Створення електронної презентації на тему "Перспектива розвитку теорії та 

практики мутьтимедіа в культурології на найближчі 5-10 років". 

 



9 

 

 

ПРАКТИЧНА РОБОТА № 4 
ТЕМА: Цифрові технології роботи з електронними документами: 

створення мультимедійної електронної книги (4 год.) 

Мета заняття: одержання практичних навичок з організації процесу 

створення мультимедійної електронної книги засобами програми Autoplay 

Media Studia. 

Зміст: після виконання практичної роботи студент повинен 

знати: 

• особливості використання майстер-сторінок; 

• особливості використання елементів навігації; 

• особливості роботи з об'єктами, настроювання їх властивостей та 

дій; 

• специфіку створення та настроювання скриптів; 

• специфіку створення автоматично відтворюваного проекту; 

вміти: 

• створювати мультимедійні електронні книги; 

• розробляти оригінальний дизайн проекту та окремих його 

складових елементів (форм, кнопок тощо); 

• розробляти елементи навігації проекту; 

• визначати властивості та дії компонентів проекту (кнопок, 

текстових блоків та ін.); 

• вмонтовувати текст, зображення, відео, аудіо; 

• вмонтовувати інсталяційні пакети та заархівовані файли; 

• створювати та використовувати скрипти; 

• створювати автоматично відтворюваний проект. 
 

ЗАВДАННЯ: 

Створення електронної мультимедійної книги "Культурологія та медіапростір", 

яка має містити всі основні елементи мультимедійних видань. 

 

ПРАКТИЧНА РОБОТА № 5 
ТЕМА: Створення складної графічної композиції за допомогою програми 

Photoshop для художнього оформлення тексту і створення спец ефектів (4 год.) 

Мета заняття: одержання практичних навичок з організації процесів 

створення, редагування, перегляду та запису графічної композиції за 

допомогою програми Photoshop. 
 

ЗАВДАННЯ: 

1. Створити текст з ефектом Напис вогнем. 

2. Створити текст з ефектом Кам’яні букви. 

3. Створити текст з ефектом Вибух. 
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4. Створити композицію Квітка в калюжі. 

5. Помістити квітку в фужер. 

6. Реставрувати "зіпсовану" фотографію.  

  

МЕТОДИЧНІ РЕКОМЕНДАЦІЇ 

Завдання 1. Створити текст з ефектом Напис вогнем: 

 

 
 

Створіть новий документ з такими параметрами: 

• висота -10 см , ширина – 20 см ; 

• роздільна здатність – 100 пікселів/см; 

• режим – Черно/Белое; колір – білий. 

1. Виберіть інструмент Текст (шрифт - Bookman Old Style; розмір - 100 pt; 

накреслення - Bold; колір - чорний). Введіть текст. Інструментом 

Переміщення розмістіть напис у центрі малюнка. 

2. об'єднайте шари: меню Шар - Склеїти з Нижнім. 

3. Створіть ефект кристалізації тексту, використавши фільтр 

Кристалізація: меню: Фільтр - Pixelate - Crystallize, розмір кристала (Cell 

Size) - 6-8 пікселів. 

4. Розмийте зображення фільтром Кругове розмиття: меню Фільтр - Blur - 

Radial Blur, радіус - 2 пікс. 

5. Інвертуйте зображення: Зобр. - Встановлення - Інвертування. 

6. Поверніть на 900 проти годинникової стрілки: меню Зображення - 

Повернути полотно - 900 проти годинникової стрілки. 

7. Для створення ефекту язичків полум'я використайте тричі фільтр Вітер: 

Фільтр - Stylize - Wind, перемикач From the Rigth. 

8. Створіть ефект коливання полум'я фільтром Бриз: Фільтр - Distort - 

Ripple, Amount (Ефект)- 70%, Size (Розмір)- Medium. 

9. Поверніть на 900 за годинниковою стрілкою: меню Зображення - 

Повернути полотно - 900 за годинниковою стрілкою. 

10. Ще раз використовуйте фільтр Бриз, Amount - 30%, Size - Large. 

11. Виконайте індексування кольорів: Зображення - Режим - Індексовані 

кольори. 

12. Замалюйте полум'я: меню Зображення - Режим - Палітра, виберіть 

таблицю Black Body. 

Завдання 2. Створити текст з ефектом Кам’яні букви: 

 

 

 

Створіть новий документ з такими параметрами: 

• висота - 10 см , ширина – 15см; 
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• роздільна здатність – 100 пікселів/см; 

• режим – RGB; колір – білий. 

1. Залийте робочу область чорним кольором. 

2. Виберіть інструмент Текст (шрифт - Times New Roman; розмір – 

130 pt; накреслення - Bold; колір - коричневий або сірий). Введіть 

текст. 

3. Переведіть текстовий шар у растровий: клацніть правою клавішею 

миші в полі текстового шару (інструментальна палітра Шари) і 

виберіть команду Растеризація шару. 

4. За допомогою інструменту Чарівна паличка виділіть літери тексту. 

Надалі всі дії будуть виконуватися над виділеним текстом. 

5. Об'єднайте шари: меню Шар - Склеїти з Нижнім. 

6. Для деформації країв тексту використовуйте фільтр Океанські хвилі: 

меню Фільтр - Distort - Ocean Ripple, Ripple Size - 7 пікс, Ripple 

Magnitude - 9 пікселів (колір фону - чорний). 

7. Щоб згладити краї, скористайтеся фільтром Кристалізація з розміром 

кристала - 7 пікселів. 

8. Для імітації нерівної поверхні використовуйте фільтр Додати шум: 

меню Фільтр - Шум - Додати шум, Кількість - 30%, виберіть параметр 

Гаусс і прапорець Одноколірний. 

9. Для імітації фактури матеріалу використовуйте фільтр Тріщини: меню 

Фільтр - Texture - Craquelure, задайте Crack Spasing (Відстань між 

тріщинами) - 32 пікселі, Crack Depth (Глибина) - 10 пікселів, Crack 

Brightness (Яскравість) - 10 пікс. 

  

Завдання 3. Створити текст з ефектом Вибух: 

Створіть новий документ з такими параметрами: 

• висота - 400 пікселів , ширина – 400 пікселів; 

• роздільна здатність – 100 пікселів/см; 

• режим – RGB; колір – білий. 

1. Виберіть інструмент Текст (шрифт – Times New Roman; розмір – 36 

pt; накреслення – Bold; колір – чорний). Введіть текст. 

2. Об’єднайте шари. 

3. Використайте фільтр Кругове розмиття, радіус – 2 пікселі. 

4. Фільтр Соляризація: меню Фільтр - Stylize - Solarize. 

5. Для збільшення яскравості букв виконайте: меню Зображення - 

Установка - Авторівні. 
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6. Зробіть копію активного шару (клацніть правою клавішею миші в 

рядку шару і виберіть Дублювати шар). Приховайте копію шару 

(непрозорість - 0 %) і перейдіть на фоновий шар. 

7. Деформуйте текст за допомогою фільтра Полярні координати: меню 

Фільтр - Distоrt - Polar Coordinates, перемикач Polar to Rectangular 

(Перевести полярні координати в прямокутні). 

8. Поверніть малюнок на 900 за годинниковою стрілкою, інвертуйте 

зображення. 

9. Для створення променів тричі використовуйте фільтр Вітер. 

10. Збільште яскравість літер: Зобр. - Установка - Авторівні. 

11. Інвертуйте зображення. Знову використайте тричі Вітер. 

12. Поверніть малюнок на 900 проти годинникової стрілки. 

13. Фільтр Полярні координати, перемикач Rectangular to Polar (Перевести 

прямокутні координати в полярні). 

14. Замалюйте зображення: меню Зображення - Налаштування - 

Відтінок/Насичення, прапорець - Кольоризація, Відтінок - 45, 

Насиченість - 100, Яскравість - 0. 

15. Зробіть видимим верхній шар і задайте для нього режим - Множення, 

непрозорість - 35%. 

  

Завдання 4. Створити композицію Квітка в калюжі: 

1. Створіть малюнок, який розділіть на дві частини: небо і воду. 

2. Для створення неба виокремте прямокутну ділянку і використайте фільтр 

Хмари: меню Фільтр - Render - Clouds, попередньо вибравши синій колір 

для малювання і білий для фону. 

3. Щоб створити воду, виокремте нижню частину зображення і заповніть 

її також хмарами, але для переднього плану виберіть голубий колір, а 

для фону – білий. Використайте також фільтр Скло: меню Фільтр - 

Distоrt - Glass. 

4. Відкрийте зображення з квіткою і виокремте квітку будь-яким 

інструментом. Перенесіть вирізану квітку на воду. 

5. Виокремте нижню частину квітки, яка має бути під водою. 

Перетворіть виокремлення у новий шар меню Шар - Новий - Шар  

через  обрізку, задайте непрозорість шару 40 – 50 %. 

6. Додайте ефект водяного брижу. Перейдіть на фоновий шар, виокремте 

еліпс навколо квітки та застосуйте фільтр: меню Фільтр - Distоrt - ZigZag, 

Аmоunt – 100, Ridges – 6, Style – Around Center. 

  

Завдання 5. Помістити квітку в фужер (зробіть зображення як на фото) 
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Завдання 6. Реставрувати “зіпсовану” фотографію (зробіть зображення як 

на фото).  
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3. ЗМІСТОВИЙ МОДУЛЬ № 2 

ПРАКТИЧНА РОБОТА № 6 
ТЕМА: Створення цифрового фотоальбому про сучасні медіакомунікації: 

перспективи розвитку інформаційних технологій у сфері культури та теорія і 

практика медіакультури (4 год.) 

Мета заняття: одержання практичних навичок з організації процесів 

створення, редагування, перегляду та запису на цифрові носії цифрового 

фотоальбому. 

Зміст: після виконання практичної роботи студент повинен 

знати: 

• функціональні можливості програми; 

• особливості здійснення процесів створення, редагування,  перегляду та 

запису цифрового альбому; 

• параметри настроювання та керування цифровим фотоальбомом; 

• особливості процесів імпорту та експорту цифрового  фотоальбому; 

вміти: 

• створювати, редагувати, переглядати та записувати цифрові фото-

альбоми на цифрові носії інформації; 

• працювати з параметрами настроювання та керування цифровим 

фотоальбомом; 

• імпортувати та експортувати цифрові фотоальбоми. 

 

ЗАВДАННЯ: 

Створення електронного альбому про сучасні медіакомунікації: 

перспективи розвитку інформаційних технологій у сфері культури та теорія і 

практика медіакультури. 

 

ПРАКТИЧНА РОБОТА №7 
ТЕМА: Створення складної графічної композиції за допомогою програми 

CorelDraw для ілюзії скла, листа календаря, міста (4 год.) 

Мета заняття: одержання практичних навичок з організації процесів 

створення, редагування, перегляду та запису на цифрові носії графічної 

композиції за допомогою програми CorelDraw. 

 

ЗАВДАННЯ: 

1. Намалювати будівлі (декілька будинків) та прибудинкову територію 

(дерева, алеї, стадіон і т.д.). 

2. Створити ілюзію скла на машині. 

3. Створити календарний лист на місяць з фото. 
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МЕТОДИЧНІ РЕКОМЕНДАЦІЇ 

Завдання 1. Намалювати будівлі. 

1. Інструментом Rectangle Tool (F6) намалюйте три прямокутника. Для 

зручності роботи з ним залийте кожин різним відтінком (фото 1). 

2. Згрупуйте об’єкти (виділіть їх і натисність ctrl+G). Застосуйте 

перспективу:  Effects > Add Perspective (фото 2). 

3. Щоб споруди були різної висоти, розгрупуйте об’єкти і пересуньте 

прямокутники вверх або вниз в залежності від того, нижче чи вище будинок ви 

хочете зробити (фото 3). 

 

   
        Фото 1   Фото 2    Фото 3 

 

4. Застосуйте Interactive Extrude Tool. Налаштування по замовчуванню, 

тяніть мишку вниз. Щоб зберегти перспективу, тяніть середній прямокутник 

рівно вниз, а крайні вниз і до центру (фото 4).  

5. Теперь необхідно перетворити ефект в окремі об’єкти: Arrange > Break 

Extrude Group Apart, потім  Ungroup. Проробіть так з кожним об’єктом. В 

результаті у вас повинно вийти 9 окремих прямокутників (фото 5).  

6. Залийте фасад більш темним кольором, а бокові стіни світлим. 

 7. У будинків повинні бути вікна. Намалюйте за допомогою  Rectangle tool 

і Shape tool (F10)  декілька вікон різної форми, а потім скопіюйте їх 

необхідну кількість разів.  

Примітка: після того, як ви скопіювали перше вікно, користуйтесь  Edit > 

Dublicate (ctrl+D) для подальшого рівномірного копіювання (фото 6).  
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        Фото 4   Фото 5    Фото 6 

 

8. Об’єднайте кожну групу вікон в один об’єкт: Arrange > Combine (ctrl+L) 

. Виберіть ефект Add Perspective і застосуйте його, щоб викривити їх і 

вписати в стіни (фото 7). 

Тепер ми маємо повноцінні будинки, але ілюстрацію треба дещо 

доповнити. 

Для завершення додамо тіні на фасад з допомогою Interactive Transparency 

Tool. 

 

   
 

        Фото 7   Фото 8    Фото 9 

 

9. Скопіюйте прямокутники і вставте поверх початкових. Розташуйте їх з 

допомогою  ctrl+PgUp/PgDn (меню Arrange > Order) зразу за вікнами. 

10. Використайте Interactive Transparency Tool і тяніть знизу вверх. 

(Застосувавши ефект до одного прямокутника, ви можете скопіювати його на 

наступний, виділивши його, натиснувши значок (Copy Transparency 

Properties) і вказавши стрілкою на об’єкт, з якого ви хочете скопіювати ефект). 

11. Виділіть всі ваші вікна і встановіть  градиент (F11): 

12. З допомогою  Freehand tool намалюйте прямокутники на дахах 

будинків, залийте їх і приберіть контур (фото 8). 
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13. Зверніть увагу, на малюнку відстань від об’єкта до спостерігача 

визначається товщиною ліній (фото 9). 

Досягти такого ефекту можна у такий спосіб: 

а) Виділіть всі сторони ваших будинків і в панелі Outline tool встановіть 

необхідну товщину контуру.  

б) Не знімаючи виділення натисніть Ctrl+Shift+Q щоб перетворити лінії в 

об’єкт. 

в) Натискаючи ctrl+PgUp розмістіть чорні лінії-об’єкти поверх стін, таким 

чином, щоб всі їх сторони були видні. 

Виберіть Shape Tool . Всі непотрібні точки, крім кутових, 

необхідно видалити. Потім дещо трансформуйте лінії.  

Доробіть будь ласка прибудинкову територію самостійно. 

 

Завдання 2. Створити ілюзію скла на машині 

1. Виберіть на панелі інструментів "Криві Безьє"  

2. Створіть довгастий трикутник. Для цього вам знадобиться всього чотири 

кліки (фото 1). 

   
        Фото 1   Фото 2     Фото 3 

 

3. Тепер починається саме цікаве. Виділите створений вами трикутник, 

відкрийте панель Extrude (видавлювання) і натисніть кнопку Edit 

(редагування). 

4. У діалоговому вікні, що з'явилося, установите тип видавлювання Back 

Parallel (паралелі). Під вашим трикутником пунктирною лінією буде 

відображатися копія. Зверніть увагу на положення перехрестя, що позначає 

крапку зникнення. Захопіть його мишкою і помістіть так, щоб домогтися 

бажаної товщини скла (фото 2). 

5. Коли ви досягнете потрібної товщини вашого "осколка", натисніть Apply 

(застосувати). Якщо все-таки захочете щось змінити, кликніть на осколку, 

зайдіть у панель "Видавлювання" і встановіть положення точки зникнення. 

Коли результат вас задовольнить, натисніть застосувати (фото 3). 

6. Тепер виділіть вихідний трикутник на створеному вами осколку. 

Кликніть на Arrange/Separate (упорядкувати/розділити). Після цього вихідний 

трикутник відокремиться від видавленого.  
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Примітка: якщо пункт Separate випадаючого меню недоступний, виходить, 

ви виділили не ту частину осколка. 

7. Після поділу ви не помітите ніяких змін на екрані. Тепер виділіть 

видавлену частину осколка.  

8. Кликніть на Un-Group (розгрупувати) і ви одержите видавлену форму, 

розбиту на три частини. 

9. Виділите по черзі кожну частину і залийте світлим блакитнувато-

зеленим кольором (C20 M0 Y0 K20). Потім видаліть контур усіх трьох частин 

(фото 4).  

  
        Фото 4   Фото 5    

 

10. Виділіть кожну частину окремо і застосуйте Fountain Transparency, 

змінюючи напрямок прозорості в кожнім випадку (фото 5).  

11. Тепер відкрийте панель Lens (лінза). Виділіть вихідний трикутник. Для 

цього можна використовувати клавішу Tab - з її допомогою ви будете 

переміщатися по об'єктах, що складає ваш осколок. Вихідний трикутник буде 

виділений рамкою. 

12. Виділивши вихідний трикутник, зайдіть у панель Lens (лінза), натисніть 

Magnify (збільшення), виберіть установку за замовчуванням (2.0) і натисніть 

Apply (застосувати). Необхідний останній крок - виділити весь осколок і 

згрупувати його. 

13. Якщо ви в точності слідували інструкціям, ваш осколок повинний 

нагадувати зображений нижче. Ви не зможете повною мірою оцінити цей 

ефект, поки не помістите під зображенням осколка фотографію. 
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Завдання 3. Створити календарний лист на місяць з фото. 

1. Натисніть двічі лівою кнопкою миші на значку . З'явиться 

прямокутник на всю площу вашої сторінки. Щоб не було видно границі 

прямокутника, натисніть правою кнопкою миші на значку в палітрі квітів .  

2. Залийте прямокутник лінійним градієнтом (F11). Кольору від салатового 

до білого, кут заливання -90 градусів. 

3. Імпортуйте потрібний вам малюнок. Для цього виберіть меню Файл - чи 

Імпорт натисніть комбінацію клавіш Ctrl+I. 

4. Після вибору малюнка у вікні Імпорт, розтягніть малюнок на екрані до 

необхідного розміру.  

5. Намалюємо таблицю під цифри. Для цього на панелі інструментів 

виберіть інструмент  міліметрівка . На панелі параметрів установите 

кількість рядків = 7, стовпців = 6 . Розтягніть таблицю нижче малюнка.  

6. Далі розгрупуйте комірки . Встановіть верхню комірку і верхню і 

бічну рядки на деякій відстані від основної таблиці, як на малюнку. Для цього 

необхідно інструментом  укласти в рамку необхідний стовпець чи рядок і, 

утримуючи Ctrl зрушити їх. 

7. Тепер вам необхідно розподілити всі комірки на однаковій відстані один 

від одного. Виділіть цілком перший рядок і натисніть на значок вирівнювання 

і розподілу . У діалоговому вікні, що відкрилося, виберіть розподіл по 

горизонталі і вертикалі по центрі. Таким же чином розподіліть інші комірки. 

8. У першому стовпці інструментом  напишіть назви днів тижня. 

Вихідні дні зробіть червоним кольором (у палітрі кольорів виберіть червоний 

колір і по черзі клацніть спочатку лівою кнопкою миші 

- колір заливання, а потім правою - колір контуру). 

Видаліть зайві комірки (виділіть і натисніть Delete). 

Напишіть у кожній комірці дату. Далі вам необхідно 

вирівняти цифри в кожній комірці окремо командою 

вирівнювання і розподіл . Спочатку виділіть цифру, 

а потім тільки комірку, тому що вирівнювання йде по 

останньому обраному об'єкті. 

9. У таблиці зеленими літерами напишіть назву 

місяця, а ліворуч від малюнка - рік. Шрифт - Monotype 

Corsiva, як на фото. 
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ПРАКТИЧНА РОБОТА № 8 

ТЕМА: Створення відео презентації за допомогою програми Canva у галузі 

віртуального простору сучасного мистецтва (4 год.) 

Мета заняття: одержання практичних навичок з організації процесів 

створення, редагування, перегляду та запису на цифрові носії відео 

презентації за допомогою програми Canva. 

 

ЗАВДАННЯ: 

Створення відео презентації про сучасні медіакомунікації за допомогою 

програми Canva у галузі віртуального простору сучасного мистецтва. Тему 

можна взяти свою або згідно варіанту. 

Варіанти: 

Тема 1. Масмедіа в системі сумісних типів художнього дискурсу. 

Представлено широкий сенс функцій культури: збереження духовних, 

інтелектуальних та матеріальних досягнень людства. Культура розглядається 

як засіб проявлення значущого буття. Промовляння стає явністю. 

Тема 2. Проблемне поле сучасних культурологічних досліджень 

України. 

Розглянуто культурологічний дискурс як вербально артикульовану форма 

об’єктивації змісту духовності, світогляду та свідомості людини в дану 

конкретну епоху. 

Тема 3. Нові медіа та художньо-інформаційна культура України. 

Досліджується сфера «медіа», що утворилася в епоху глобалізації. 

Акцентується увага на поняттях «нові медіа», «мистецтва медіа». 

«Медіакультура» - як концепт сучасної культурологічної думки. 

Тема 4. Від засобів масової комунікації до соціальних мереж: огляд 

українського контенту. 

Використання соціумом усного мовлення – сценічна мова, художні 

читання, ораторська діяльність. Масмедійне мовлення розглядається як 

універсальний засіб людського спілкування, як спонукальний дискурс. 

Тема 5. Медіакомунікативний вимір телевізійної культури. 

Дослідження новоутвореної сфери глобалізаційної епохи – медійної 

культури; акцентується увага на змісті терміну «медіакультура» як концепту 

сучасної культурологічної думки. 

Тема 6. Від мови дискурсу до мови мистецтва: сучасні 

медіакомунікації. 

Медіакультура в контексті дослідження масової культури. Стирання 

кордонів між «масовим» та «елітарним» за допомогою принципу подвійного 

кодування. 
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Тема 7. Нова візуальність масмедіа. 

Аналіз наукових досліджень, що присвячені існуванню сучасних 

масмедійних засобів та їх структури. Запропоновано підходи соціокультурних 

умов діяльності медій. 

Тема 8. Структура масмедіа і суспільство нової візуальності. 

Досліджено теорію Дж. Мердока щодо структури та функціонування 

сучасних медіа. Вплив на сучасні масмедійні засоби громадської стратегії. 

Підкреслено місце, роль і значення масмедійних регуляцій у світових 

демократичних процесах. 

Тема 9. Семіологія телевізійного мистецтва. 

Представлення семіотичного світу телевізійної культури. Визначено 

провідну роль телевізійного дискурсу; досліджено власні коди телебачення. 

Тема 10. Регулятивні чинники телевізійного мистецтва. 

Розглянуто контексти телевізійного мистецтва. Зазначено факт нового виду 

інформаційних програм – «інфотейнмент»: новини в максимально 

розважальній формі. 

Тема 11. Аспекти діяльності масмедіа у вітчизняному 

телекомунікаційному просторі. 

Представлено традиційне і новітнє розуміння візуального мистецтва з 

точки зору його функціональності. Виокремлено масмедійний елемент 

мистецьких течій з моделюванням просторових візуальностей полікультурного 

середовища. 

Тема 12. Мистецтвознавчий підхід до сучасних масмедіа. 

Підкреслено, що у контексті кризи української культури, її цінностей, 

приділено увагу темі національної художньої образності у масмедійному 

контенті. Підкреслено інваріантність та виокремлення простором перетину 

національних образів світу. Доведено, що в основу розуміння людської 

творчості будь-якого різновиду покладено ментальність. 

 

ПРАКТИЧНА РОБОТА № 9 

ТЕМА: Створення відео презентації в YouCut для практичного 

використання індустріями культури (4 год.)  

Мета заняття: одержання практичних навичок з організації процесів 

створення, редагування, перегляду та запису на цифрові носії відео 

презентації в YouCut. 

 

ЗАВДАННЯ: 

Створення відео презентації про сучасні медіакомунікації в YouCut у галузі 

віртуального простору сучасного мистецтва. Тему можна взяти свою або 

згідно варіанту. 
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Варіанти: 

Тема 1. Соціокультура і система масмедійних трансформацій: 

український контекст. 

Представлення доречності музикознавчого і естетичного напрямів у 

соціологічному науковому дискурсі; завдання масмедіа як перегук із 

завданням соціальних функцій. Функції масмедіа як засіб спілкування у 

середині музичного осередку й з соціумом загалом. 

Тема 2. Вплив ЗМК на формування соціокультурних засад суспільства. 

Підкреслено роль соціальної самоорганізації культуротворчості у сегменті 

посилення глобалізаційних тенденцій громадянського суспільства України. 

Окреслено напрямок поступу сучасного глобалізаційного суспільства – 

становлення інформаційної індустрії. 

Тема 3. Роль телекомунікації у формуванні колективної ідентичності 

народу. 

Досліджено вплив регіонального телебачення на формування 

соціокультурної свідомості та запитів соціокультурної сфери. Регіональне 

телебачення як синтез сучасних комунікацій. 

Тема 4. Соціокультурні традиції регіонального телебачення. 

Визначення специфіки даного регіону: соціально-економічні та духовно-

світоглядні, художні характеристики і запити. Визначення парадигми певних 

локально-регіональних культурних цінностей. 

Тема 5. Тенденції розвитку культурознавства. 

Дослідження нових локальних художньо-комунікативних форм у 

глобалізованому медіапросторі. Аналіз форм, складу і структури художньо-

комунікативних форм; практика індивідуалізованих спільнот. Унаочнення 

процесу інтеграції опосередкованих соціальних та художньо-мистецьких 

зв’язків у мережу Інтернет-комунікацій. 

Тема 6. Мистецтво телекомунікації у полі культури і проблема меж. 

Досліджено нові художньо-комунікативні форми у глобалізованому 

медіапросторі та їх відмінність від класичних рамок наукового 

теоретизування. Унаочнено процес інтеграції опосередкованих соціальних та 

художньо-мистецьких зв’язків у мережу Інтернет-комунікації. 

Тема 7. Коди телебачення: огляд. 

Аналіз діючих теорій про телевізійні коди. Кодова модель сучасного 

соціуму. 

Тема 8. Діаголізм – цінність «культурних кодів». 

Представлено «діалогізм» як певну свідому вибрану цінність та один з 

«культурних кодів», висвітлено ґенезу цього феномена. «Розкодування» 

смислобуттєвих питань: «хто ми?», «які ми?», «чому ми такі?». 
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Тема 9. Комунікативні системи як процеси існування культури. 

Огляд теоретико-методологічних обґрунтувань розуміння культури як 

комунікативної системи, міжкультурної комунікації, кроскультурного діалогу. 

Тема 10. Функціональність комунікативних систем. 

Означення основних аспектів, структури, функцій, типів та особливостей 

взаємодії гуманітарних комунікативних систем. 

Тема 11. Міжкультурна комунікація. 

Представлено теоретичні напрацювання на предмет здобутків та 

досліджень у цій темі. Досліджено поняттєвий апарат міжкультурної 

комунікації, формування та розвиток серед учасників міжкультурної 

комунікації взаємного сприйняття. 

Тема 12. Історико-культурний діалог України: європейський вектор. 

Представлено засади міжкультурних діалогів: як медіа культурного явища; 

як міжнародних, міжетнічних, міждержавних взаємин. Обґрунтування 

можливості використання цього культуротворчого ресурсу. 

 

 

4. ОРІЄНТОВНИЙ СПИСОК КОНТРОЛЬНИХ ПИТАНЬ: 

1. Роль масмедіа, соціальних мереж в комунікаційних системах сучасного 

суспільства. 

2. Телевізійна культура в медіакомунікативному вимірі. 

3. Нова візуальність суспільства: сучасні теоретико-культурознавчі 

підходи. 

4. Структура масмедіа в суспільстві нової візуальності: культуролознавчі і 

мистецтвознавчі проблеми. 

5. Теорії Д.Альтштула та Д.Мак-Квейла як підходи до соціокультурних 

умов дійсності медій. 

6. Національні медіа як політичний аспект діяльності держави: до питань 

культури. 

7. Соціальні мережі як інструментарій формування культурологічного 

середовища. 

8. Цінності та символи культурологічних надбань сучасності. 

9. Власні коди масмедіа і телебачення: від практичного і комунікативного 

до культурологічного поняття. 

10. Типи телевізійних кодів: від теорій Дж.Фіске до сучасних наукових 

трансформацій. 

11. Соціокультурні механізми у популярній культурі: формування 

культурологічних норм. 

12. Види інформаційних культурологічних програм: типологія норм. 

13. Система масмедійних соціокультурних трансформацій: український 

контекст. 
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5. ЗАВДАННЯ ДЛЯ САМОСТІЙНОГО ОПРАЦЮВАННЯ: 

1. Специфіка медіакомуніккації: культурологічний аспект.  

2. Особливості філософсько-культурологічного підходу до аналізу медіа. 

Теорія "медіатизації" С.Жижека. Естетико-культурологічний аналіз 

медіамистецтва (Б. Гройс).  

3. Критерії культурологічного аналізу функціональної природи 

медіакультури. Медіакультура як фактор глобалізації та нівелювання 

соціокультурних відмінностей.  

4. Віртуальна реальність в контексті постмодерної культури.  

5. Суперечливість впливу медіа на становлення особистості. Поняття 

"людини телематичної" (Ж.Бодріяр).  

6. Спеціалізація журнальної преси за віковими та гендерними 

критеріями. Феномен глянцю.  

7. Фотографія в контексті туризму як культурного феномену. 

Суперечливі наслідки впливу фотографії на образотворче мистецтво 

та літературу.  

8. Екранна реальність і смак симулякру. Людина телематична: зміна 

парадигми чуттєвості. Глядач як об’єкт маніпулювання.  

9. Сучасні анімаційні технології. Феномени "аніме", "касплея", фан-арту.  
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